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CHAPTER

ONE

OVERVIEW

Fig. 1.1: Xena1564 overview

This is the user manual for Xena1564. Xena1564 is a PC application that lets you perform
advanced network tests according to the ITU-T Y.1564 standard using one or more of the Xena
test equipment chassis.

The Xena1564 application features the following capabilities:

• Enables the user to create, edit and execute test configurations using Xena Networks test
equipment in accordance with the ITU-T Y.1564 standard.

• Define test configuration using standard MEF 10.2 / ITU-T Y.1564 terminology.

• Full support for both ITU-T Y.1564 configuration and performance test types.

• Ability to define multiple Ethernet services.

• Ability to execute test on one, several or all defined Ethernet services.

• Ability to organize defined services in a custom folder hierarchy.
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• Support for multiple ValkyrieBay and ValkyrieCompact test chassis.

• Support for different network topologies and traffic flow directions.

• Support for both layer 2 and layer 3 testing.

• Support for either IPv4 or IPv6.

• Ability to flexibly define the protocol layers supported by each user-to-network interface
(UNI) - Ethernet, Customer and Service VLANs, MPLS, IP and UDP.

• Ability to define either per-UNI or per-CoS bandwidth profiles for each UNI.

• Ability to specify CoS-to-DSCP mapping.

• Test reports can be created in either PDF or XML format or both.

• Extensive configuration options to fine-tune the tests.

2 Chapter 1. Overview



CHAPTER

TWO

INSTALLATION

Xena1564 is a Windows desktop application compatible with Windows 8 and later versions.

It comes pre-installed as an integral component of the standard Xena software release package,
which is available for download from this source.

Following the installation, you can locate a shortcut to the application in the Start → Programs
→ Xena Network menu, and additionally (if you opted for this during the setup process), on
your desktop.

3
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CHAPTER

THREE

GETTING STARTED

This section explains how to create a few common test configurations.

3.1 EPL, Port-Based

In this scenario we will create a simple EPL service with no VLAN multiplexing on the UNI
(i.e. port-based) using plain Ethernet traffic.

3.1.1 Add Chassis

1. Click the Add Chassis button in the main toolbar. This will display the dialog shown
below.

Fig. 3.1: Add Chassis button

2. Enter the IP address and password of a Xena chassis and press OK.

5
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Fig. 3.2: Add Chassis dialog window

Fig. 3.3: Chassis added

3.1.2 Create Service

Create a new Ethernet service either by clicking the Create Service icon in the small toolbar at
the top of the Defined Services tree panel, located at the left part of the application, or by right-
clicking on the All Services root in the Defined Services tree panel and selecting the Create
Service menu option. This will display the dialog shown in the image.

1. Enter a suitable label for the service to make it easy to identify it later on.

2. Set the Service Type to EPL (should be the default choice). Leave the Is Virtual Service
checkbox unchecked as we want to define a port-based service.

3. Optionally modify the Service Acceptance Criteria to use in the test. These values rep-
resents the guarantees you want to issue to the user of the service as part of the Service
Level Agreement (SLA) for this service. If one or more of the criteria should not be used
in the test you can deselect them using the Use in test checkboxes to the right.

4. Finally you need to specify the Testflow Characteristics. For an EPL you can only select
the Pairs topology as the other topology options are only relevant for multipoint config-
urations. You can however select the direction for the test traffic. You should keep the
default choice of Bidirectional for this test.

5. Press the EPL``Create button to create your service.

6 Chapter 3. Getting Started
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Fig. 3.4: Create Service

Fig. 3.5: Create Service dialog - EPL

3.1. EPL, Port-Based 7
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3.1.3 Create Bandwidth Profile

1. Switch to the Bandwidth Profiles panel and click the Create Profile button in the small
toolbar at the top of the panel. A new entry will now be inserted in the list below. If you
cannot see the Bandwidth Profiles panel tab in the tabbed view you can either enlarge the
main window until the tab pops into view or you can select the Bandwidth Profiles menu
item in the View menu. Alternatively you can click on the little down-arrow in the right
edge of the tab-bar and select the Bandwidth Profiles panel.

Fig. 3.6: Create Bandwidth Profile

2. Click the cell in the CIR column and enter the committed bandwidth you want the UNIs
to provide.

Fig. 3.7: Edit Bandwidth Profile

3. Optionally click the cell in the EIR column and enter the additional excess bandwidth you
want the UNIs to provide.

4. You can also optionally modify the CBS and EBS values. The default value for both is
12176, according to MEF 13, clause 36.

8 Chapter 3. Getting Started
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3.1.4 Add UNIs

1. Switch to the Physical Ports panel. Expand the module(s) as needed and locate two ports
that you want to use in your test.

2. Select the ports, either one by one or both at the same time, drag them to the service you
created in the Defined Services tree view and drop them onto the service.

Fig. 3.8: Drag and drop ports to service

3. The two UNIs will now be shown under the service in the services tree view. Notice that
the cells under the Group column contains the text Select Group. . . . Change this value to
EAST for the first UNI and WEST for the other.

4. Switch to the Service/UNI Configuration panel. Select the first UNI to view the UNI
configuration panel as shown below.

5. For this test we will just leave the default traffic settings (plain Ethernet, no VLANs, no
IP, etc).

6. Select the Ingress Bandwidth Profiles sub-tab and set the Per-UNI Bandwidth Profile to
point to the profile we just created.

7. Do the same for the other UNI.

8. Save your configuration and give it a suitable filename.

3.1. EPL, Port-Based 9
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Fig. 3.9: Service UNI panel

Fig. 3.10: Ingress Bandwidth Profile panel

10 Chapter 3. Getting Started
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3.1.5 Start Configuration Test

Fig. 3.11: Configuration Test Panel

1. Click the Start Configuration Test button in the main toolbar.

2. The Result Data Grid panel will now be shown automatically. Here you can follow the
progress of the test.

3. Once the test completes the resulting PDF report should open automatically in the default
PDF viewer application on your PC.

3.1.6 Start Performance Test

1. Click the Start Performance Test button in the main toolbar.

2. The Result Data Grid panel will now be shown automatically. Here you can follow the
progress of the test.

3. Once the test completes the resulting PDF report should open automatically in the default
PDF viewer application on your PC.

3.1. EPL, Port-Based 11
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Fig. 3.12: Performance Test Panel

3.2 E-LAN, Port-Based

This example expands a bit on the first example and will thus only describe the new features in
details. You can either use the same configuration as for the first example or you can create a
new configuration.

1. Add a Xena chassis to the configuration (or re-use the one you already have).

2. Create a new Ethernet service. Set the Service Type to E-LAN. Set the testflow topology
to Mesh.

3. Select 3 suitable ports in the Physical Ports panel and drag and drop them to the service
you just created.

4. Set the Per-UNI bandwidth profile for each UNI to a suitable bandwidth profile (reuse the
one you created before or create a new one for this test.

5. Save your configuration.

6. Right-click on the service you just created in the Defined Services tree view and select
the Run Configuration Test (for this service only) item.

12 Chapter 3. Getting Started
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Fig. 3.13: Create Service dialog - E-LAN (Mesh)

3.3 EPL With C-Tag

This example also expands on the first example and shows how to add service multiplexing using
a Customer VLAN tag (C-TAG) and also how to enable per-CoS bandwidth profiles. We will
create an EVPL service with a C-TAG value of 10, using bandwidth profiles for CoS value 1
and 5.

1. Add a Xena chassis to the configuration (or re-use the one you already have).

2. Create a new Ethernet service. Set the Service Type to EPL and check the Is Virtual
checkbox.

3. Go to the Bandwidth Profiles panel and create and configure two new profiles, one for
each CoS value we want to use. The CIR/EIR values should preferably be different so
that you can see a difference when you run the test.

4. Add two suitable ports to the service. Assign each of the ports to a different direction
group (EAST or WEST).

5. Select both UNIs in the tree view and change to the Service/UNI Configuration panel.
Check the VLAN: Customer Tag checkbox and set the C-tag value in the Frame Editor to
10.

6. Change to the Ingress Bandwidth Profiles tab. Select the Use Per-CoS Bandwidth Profiles
option.

7. Press the Add button. Set the CoS value to 1 and select the first profile you created above.
Ignore the DSCP settings and press OK.

3.3. EPL With C-Tag 13
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Fig. 3.14: Create Service dialog - EPL (is virtual)

Fig. 3.15: Add C-Tag 10 to UNI

14 Chapter 3. Getting Started
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Fig. 3.16: Use Per-CoS Bandwidth Profile

8. Add another CoS-profile mapping for CoS value 5.

9. Save your configuration.

10. Right-click on the service you just created in the Defined Services tree view and select
the Run Configuration Test (for this service only) item.

3.4 EPL with IP

This example shows how to setup IP traffic on a service.

1. Add a Xena chassis to the configuration (or re-use the one you already have).

2. Create a new Ethernet service. Set the Service Type to EPL.

3. Change to the Physical Ports panel. Select two suitable ports to use and assign an IP
address to each in the configuration panel at the bottom of the main port panel. Optionally
assign a gateway address as well if your network setup requires this.

4. Add the two ports to the service as UNIs. Assign each of the UNIs to a different direction
group (EAST or WEST).

5. Select both UNIs and enable IPv4 Header in the Frame Configuration. Also assign a
bandwidth profile to each UNI.

6. Save your configuration.

3.4. EPL with IP 15
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Fig. 3.17: Enable IP in UNI

7. Right-click on the service you just created in the Defined Services tree view and select
the Run Configuration Test (for this service only) item.

16 Chapter 3. Getting Started



CHAPTER

FOUR

GENERAL PANELS

The application uses a tabbed panel layout to divide the functionality into separate areas. The
following sections briefly explain the main areas of the GUI.

4.1 Main Application View

The main Xena1564 application view is shown in the image below.

The numbered parts of the view are:

1. The menu bar.

2. The toolbar providing easy access to the most needed functions in the menu bar.

3. The main tabbed panel containing the function panels.

4. The service tree view showing all defined services and their UNIs.

5. Content of the main tabbed panel.

17
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6. The results grid and plot panels - here shown in hidden state.

7. The status bar showing current status and progress information.

18 Chapter 4. General Panels



CHAPTER

FIVE

TEST CONFIGURATION PANELS

5.1 Ethernet Service Creation Dialog

Fig. 5.1: Ethernet Service creation dialog

5.1.1 Service Type

Ethernet Private Line (EPL)

Ethernet Private Line is a Point-to-Point service. It consists of two User Network Interfaces
(UNIs) with one EVC provisioned between them.

19
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Fig. 5.2: Ethernet Private Line (EPL)

Ethernet Virtual Private Line (EVPL)

Ethernet Virtual Private Line (EVPL) is a Point-to-Multipoint service. It consists of two or
more user network interfaces (UNIs) with multiple EVCs between them (service multiplexing).

Ethernet Local Area Networks (E-LAN)

Ethernet Local Area Networks (E-LAN) - provides a multipoint topology like a local network.
Each node can reach any other node.

Ethernet Tree (E-Tree)

Ethernet Tree (E-Tree) - a rooted multi-point service that connects a number of UNIs providing
sites with hub and spoke multipoint connectivity. Each UNI is designated as either root or leaf .

5.1.2 Service Acceptance Criteria

These values represents the guarantees you want to issue to the user of the service as part of the
Service Level Agreement (SLA) for this service. If one or more of the criteria should not be
used in the test you can deselect them using the Use in test checkboxes to the right.

20 Chapter 5. Test Configuration Panels
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Fig. 5.3: Ethernet Virtual Private Line (EVPL)

Fig. 5.4: Ethernet Local Area Networks (E-LAN)

5.1. Ethernet Service Creation Dialog 21
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Fig. 5.5: Ethernet Tree (E-Tree)

5.1.3 Testflow Characteristics

Specify the Testflow Characteristics. For an EPL you can only select the “Pairs” topology as
the other topology options are only relevant for multipoint configurations.

You can, however, select the direction for the test traffic. You should keep the default choice of
“Bidirectional” for this test.

5.2 Physical Ports Panel

Drag and Drop the ports you want to use on to the right service.

5.2.1 Port Settings

• Inter-Frame Gap

Specifies the minimum gap between frames generated for a port, expressed as a number
of bytes.

• Speed Reduction

Specifies an optional speed reduction on the transmit side of the port, expressed as a ppm
value.

• Enable PAUSE Mode

Controls whether the port responds to incoming PAUSE frames.

22 Chapter 5. Test Configuration Panels
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Fig. 5.6: Add ports to service

Fig. 5.7: Port Settings

5.2. Physical Ports Panel 23
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• Enable Auto-Negotiation

Controls whether auto-negotiation for the port is enabled or not.

• Latency Offset

An optional offset in nanoseconds for the port which is used for latency measurements.
You can measure an appropriate value for this by looping two test ports together and
performing a latency test. The resulting average latency of this test should be zero. If this
is not the case you can adjust the Latency Offset value until you reach a zero value. Then
you can use the calibrated value in other tests.

5.2.2 IP Address

Fig. 5.8: IP Address

Set the IP Address IPv4/IPv4 if this is a Layer 3 test.

5.2.3 Public IP Address

Fig. 5.9: Public IP Address

• Public IP Address

If a port is located behind a NAT firewall/router it may be necessary to provide the public
IP address offered by the NAT firewall/router.

24 Chapter 5. Test Configuration Panels
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Xena1564 will then perform an ARP request for the public IP address before starting the
test to avoid packet loss due to an initial ARP phase.The real (internal) IP address of the
port must still be configured in the main port grid as this may be used to send Gratuitous
ARP packets from the port to the router before starting the test.

• Public IP Prefix

The network prefix value for the public IP address.

5.2.4 Remote Loop IP Address

Fig. 5.10: Remote Loop IP Address

When a port with layer-3 protocol segments (IPv4/IPv6) has been configured as a looped port
you must specify the IP address of the remote port so that the Xena tester can perform an ARP
request for the MAC address.

5.3 Service UNI Configuration Panel

5.3.1 Frame Configuration

• Frame Header Composition

Select the needed headers for the test. Fill in the values for the selected headers.

• Frame Payload

Defines the payload type and value.

– Pattern mean you can set your own custom pattern.

– Incrementing means 000102030405...FF00010203... provides built-in data in-
tegrity check for payload.

– PRBS provides Pseudo Random Bit Sequence of 2^31-1 pattern. No data integrity
with adding Payload checksum in port properties

5.3. Service UNI Configuration Panel 25
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Fig. 5.11: Frame Configuration

5.3.2 Ingress Bandwidth Profiles

Limits the rates of frames entering the CEN. Bandwidth Profile can be applied: Per UNI or Per
CoS.

5.3.3 Egress Bandwidth Profiles

Limits the rates of frames entering the CEN. Bandwidth Profile can be applied: Per UNI.

5.4 Bandwidth Profile Panel

A Bandwidth Profile (BWP) enforces limits on bandwidth utilization according to the Service
Level Specification (SLS) that has been agreed upon by the Subscriber and the Service Provider
as part of the Service Level Agreement (SLA). It can be thought of as enforcing the long term
average guaranteed bandwidth (CIR) and excess bandwidth (EIR) allowed by the service.

Select the Bandwidth Profiles tab and click the Create Profile button in the small toolbar at the
top of the panel.

Click the cell in the CIR column and enter the committed bandwidth you want the UNIs to
provide.

Optionally, click the cell in the EIR column and enter the additional excess bandwidth you want
the UNIs to provide.

You can also optionally modify the CBS and EBS values. The default value for both is 12176,
according to MEF 13, clause 36.

26 Chapter 5. Test Configuration Panels
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Fig. 5.12: Ingress Bandwidth Profiles (Per UNI)

Fig. 5.13: Ingress Bandwidth Profiles (Per CoS)

5.4. Bandwidth Profile Panel 27
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Fig. 5.14: Egress Bandwidth Profiles (Per UNI)

Fig. 5.15: Bandwidth Profile panel

28 Chapter 5. Test Configuration Panels
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5.4.1 CIR - Committed Information Rate

CIR (Committed Information Rate) is the bit rate for which the SP provides performance guar-
antees in terms of performance attributes for the service.

5.4.2 EIR - Excess Information Rate

EIR (Excess Information Rate) is the additional bit-rate that the subscriber can utilize and for
which traffic can probably pass through the CEN as long as there is no congestion.

Note: Note that the total rate, sometimes known as PIR (Peak Information Rate), is the sum of
CIR and EIR.

5.4.3 CBS - Committed Burst Size

The short-term burst, in bytes, allowed on the UNI for traffic to be conformant.

5.4.4 EBS - Excess Burst Size

The additional short-term burst, in bytes, allowed on the UNI.

5.4.5 Color Markings

Fig. 5.16: Color Markings

• Green

Frames within the CIR / CBS compliance level. These frames are subject to the SLS.

5.4. Bandwidth Profile Panel 29
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• Yellow

Frames exceeding the CIR/CBS but are within the EIR/EBS. These frames are delivered
as “best effort” without being subject to the SLS. The CEN may drop some or all of these
frames based on congestion conditions in the network.

• Red

Frames that do not conform to either the CIR/CBS or the EIR/EBS are dropped.

5.5 Configuration Test Panel

Fig. 5.17: Configuration Test Panel

5.5.1 Select Test Steps

• Simple CIR validation test Y.1564, chapter 8.1.2, test A.1.

During the test, the transmitting probe generates frames at the CIR rate.

The receiving probe measures the received rate, loss, delay, and jitter on the stream. The
test fails if any of the maximum frame loss ratio, delay, or jitter thresholds are violated.

• EIR configuration test - Y.1564, chapter 8.1.2, test B.

During the test, the transmitting probe generates frames at the CIR + EIR rate.

The receiving probe measures received rate, loss, delay, and jitter on the stream. The test
fails if the measured rate is less than CIR*( 1-max_loss ).

30 Chapter 5. Test Configuration Panels
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5.5.2 Test Execution Parameters

Common Parameters

• Duration

Fill in the duration of each iteration.

• Iterations

Fill in the number of iteration per this test.

• Break Test On Fail

Stop test immediately as it would imply a configuration error.

CIR Step-Load Parameters

• Start Rate

The Rate in which the test will start.

• Step Rate

The Rate increment value.

Traffic Policing Parameters

• Grace Factor

This is the value referred to in the standard as M Factor. The M factor is added to allow
for the effect of the traffic policer’s CBS and EBS settings, and test time.

L3 Address Refresh

If the Enable Refresh checkbox is checked the tester will periodically emit ARP requests (for
IPv4) or Neighbor Advertisement requests (for IPv6).

The period can be set using the Refresh Period field.

Misc. Settings

• Latency Mode

Select the Latency mode to be measured.

5.5. Configuration Test Panel 31
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5.5.3 Frame Sizes

• ITU-T Default

The default setting is to use the ITU-T standard frame sizes: 64, 128, 256, 512, 1024,
1280 and 1518 bytes.

• Custom Sizes

Lets you specify a comma-separated list of values - useful if you only want to test using
one or two packet sizes

• Size Range

Lets you specify a a range of packet sizes and the steps.

• Incrementing Sizes

Lets you specify a Min and Max size - the sizes: Min,Min+1,Min+2,. . . ,Max.

• Butterfly Sizes:

Lets you specify a Min and Max size - the sizes: Min, Max, Min+1, Max-1, Min+2,
Max-2,. . .

• Random Sizes:

Lets you specify a Min and Max size - the sizes will vary between Min and Max randomly.

5.6 Performance Test Panel

Fig. 5.18: Performance Test Panel

32 Chapter 5. Test Configuration Panels
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5.6.1 Time Period

Select how long you would like to run the test.

Unbounded mean it will stopped manually by the user.

5.6.2 Availability Settings

The Ethernet service availability definition is based on a model which uses two states corre-
sponding to the ability or inability of the network to sustain the service in the available state.
Transitions between the states of the model are governed by the occurrence of patterns of Severe
Errored Second (SES) in the Ethernet layer (SESETH). This Recommendation views availabil-
ity from the network perspective, where availability performance is characterized independently
of user behavior.

A period of unavailable time begins at the onset of 10 consecutive SESETH outcomes. The cor-
responding period of time is considered to be part of unavailable time. During the unavailable
time period, the Ethernet network is in unavailable state. A new period of available time begins
at the onset of 10 consecutive non-SESETH outcomes. The corresponding period of time is
considered to be part of available time. During the available time period, the Ethernet network
is in available state. The figure below illustrates the definition of criteria for transition to/from
the unavailable state.

This definition of availability has been chosen to allow comparison with other link layer tech-
niques.

Fig. 5.19: Criteria for transition to/from the unavailable state

See also:

Detailed explanation in ITU-T Y.1563

5.6. Performance Test Panel 33
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5.6.3 L3 Address Refresh

If the Enable Refresh checkbox is checked the tester will periodically emit ARP requests (for
IPv4) or Neighbor Advertisement requests (for IPv6).

The period can be set using the Refresh Period field.

5.6.4 Misc. Settings

• Latency Mode: Select the Latency mode to be measured.

5.6.5 Frame Sizes

• ITU-T Default

The default setting is to use the ITU-T standard frame sizes: 64, 128, 256, 512, 1024,
1280 and 1518 bytes.

• Custom Sizes

Lets you specify a comma-separated list of values - useful if you only want to test using
one or two packet sizes

• Size Range

Lets you specify a a range of packet sizes and the steps.

• Incrementing Sizes

Lets you specify a Min and Max size - the sizes: Min,Min+1,Min+2,. . . ,Max.

• Butterfly Sizes:

Lets you specify a Min and Max size - the sizes: Min, Max, Min+1, Max-1, Min+2,
Max-2,. . .

• Random Sizes:

Lets you specify a Min and Max size - the sizes will vary between Min and Max randomly.

5.7 Reporting Options Panel

The Reporting tab contains a number of options that affect the way reports are generated for the
test.

34 Chapter 5. Test Configuration Panels
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Fig. 5.20: Reporting Options Panel

5.7.1 Identification

This section contains a number of options that can help identify the test context.

• Customer Name

The name of the customer for which the test is performed.

• Customer Service/Access Id

These two options allow you to provide details about the network circuits you are testing.

• Comments

Allows you to provide any multi-line comments for the test configuration.

5.7.2 Report Generation

This section contains options that affect the way reports are generated.

• Report Filename Prefix

Specifies the prefix for the report filename.

• Append Timestamp to Filename

If checked a timestamp on the form <YYYYMMDD-HHMMSS> is appended to the filename
prefix.

• Include Graphs in Report

If checked the report will include bar charts showing the test results. This is only appli-
cable for PDF type reports.

5.7. Reporting Options Panel 35
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5.7.3 Report Formats

This section allows you to select which types of reports will be generated. You can enable
several types. The generated report files will be given a file extension that matches the selected
type, i.e. “.pdf” for PDF files and so forth.

5.7.4 XML Report Specification

You can find the specification for the XML Report here.

36 Chapter 5. Test Configuration Panels
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SIX

TROUBLESHOOTING

This section contains some guidelines when you encounter a problem with Xena2544,
Xena2889, Xena3918, Xena1564, and XenaManager and want to obtain help from your sup-
port representative.

6.1 Basic Instructions

This section explains how you should report a problem to your support representative.

6.1.1 Describe the Problem

To enable fast resolution of your problem we request that your support request contains the
following information:

• Name and version of the Xena test software used (the version can be seen in the main title
bar)

• A description of what you are trying to do with the software.

• If the software misbehaved please describe what you actually encountered and you ex-
pected instead.

• Screenshots of any error situation.

• The test configuration file for the application (contained in the support archive).

• Any debug log files for the application (contained in the support archive).

6.1.2 Create a Support Information Archive

The Xena test applications include a menu entry called Create Support Information Archive
which will create a compressed ZIP archive containing both the currently loaded configuration
file and the content of the Logs and Settings directories. This file can then be emailed to your
support representative.

For the Xena2544 and similar test applications this menu entry is located in the Help menu. For
the XenaManager application it is located in the Tools ribbon menu.
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Note: For the Xena2544 and similar test applications it is important that the configuration file
used when the problem was detected is loaded when the support archive is generated. Otherwise
the configuration file will not be part of the archive.

6.1.3 Attach Screenshots

Screenshots are a great and easy way of communicating what you see on the screen. To obtain
a screenshot of a running program and send it to Xena support perform the following actions:

1. Point your mouse inside the program window.

2. Press the Alt-PrintSc keys simultaneously.

3. Switch to your email program and start a new email message.

4. Press Ctrl-V or select Paste from the menu (most likely the Edit menu) to insert the
screenshot into the email.

6.2 Additional Details

This section goes into a bit more detail about the various items contained in the Xena Support
Archive mentioned above.

6.2.1 Configuration Files

The Xena test applications keeps their configurations in special files with an application-specific
extension. The extensions used are as follows:

• Xena2544: .x2544

• Xena2889: .x1564

• Xena3918: .x3918

• Xena1564: .x1564

• XenaManager: .xmcfg
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The configuration files will be located in a common Xena data directory
on your PC. More specifically they will be located in the following path:
C:<UserAppDataDir>Xena<XenaTestApplication>. The <UserAppDataDir> direc-
tory depends on your Windows version.

The Xena test applications include a menu entry called Explore Xena Data Directory in the File
menu that will open a Windows Explorer in the correct directory, regardless of the Windows
version.

6.2.2 Debug Log Files

The Xena test applications logs certain events and errors to a series of debug log file located
in the Logs subdirectory under the above mentioned main application data directory. If you
encounter errors it may help the support if you include these files in your support request.
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CHAPTER

SEVEN

GLOSSARY OF TERMS

ARP
Address Resolution Protocol

CBS
Committed Burst Size

CIR
Committed Information Rate

CLI
Command Line Interface

DHCP
Dynamic Host Configuration Protocol

DIP
Destination IP address

DMAC
Destination MAC address

DSCP
Differentiated Services Bode Point

IPv4
Internet Protocol v4

IPv6
Internet Protocol v6

LAN
Local Area Network

MAC
Media Access Control

MPLS
Multiprotocol Label Switching (MPLS) is a routing technique in telecommunications net-
works that directs data from one node to the next based on labels rather than network
addresses.
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N.A.
Not Available / Not Applicable

PCP
Priority Code Point

PRBS
Pseudorandom Binary Sequence is a binary sequence that, while generated with a deter-
ministic algorithm, is difficult to predict and exhibits statistical behavior similar to a truly
random sequence.

SES
Severe Errored Second

SMAC
Source MAC address

TC
Traffic Class

TCP
Transmission Control Protocol

TG
Traffic Generation

TPID
Test Payload ID

TPLD
Test Payload Data. Each Xena test packet contains a special proprietary data area called
the Test Payload Data, which contains various information about the packet. The TPLD
is located just before the Ethernet FCS.

UDP
User Datagram Protocol

UI
User Interface

UNI
User-to-Network Interface

VID
VLAN ID

VLAN
Virtual local area network (VLAN) is any broadcast domain that is partitioned and isolated
in a computer network at the data link layer (OSI layer 2).
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